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I. What is a Pivot Table? 
 
Excel’s Pivot Table is probably the most useful and time-saving tool for analyzing data 
that’s in table format. In the simplest Pivot Table, one identifies a row value, a column 
value, and a data value. The data value (usually a numeric value) in this simple Pivot 
Table is automatically summarized at each row and column intersection.  
 
The illustration at right 
shows a small part of a 
table of data in Excel 
2007.  
 
The data can be 
organized into a Pivot 
Table where Region 
values are the Pivot 
Table’s row field, 
Product values are the 
column field, and 
Revenue values are 
summarized in the data 
field.  
 
At each row/column intersection is the sum of Revenue for that combination of row and 
column value. For example: 
 

Total Revenue for A/C Capacitors in the East region is $152,500. 
Total Revenue for Overflow Switches in the West region is $211,875. 
Total Revenue for Service Valve Caps in the North region is $6,165. 

 
 
 
 
 
 
 
 
The data can be presented as a 
Pivot Table, as a Pivot Chart, or as 
both at the same time.  
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The Pivot Table invites data exploration and analysis: “slicing and dicing” large 
amounts of data is easy. The example Pivot Table above shows revenues for only three 
of the 14 products in the data. The Pivot Table can help a user spot trends and patterns 
in the data and allows for easy comparisons. Using a Pivot Table one can zoom in on 
particular data or parts of the data for micro-analysis or zoom out for macro views.  
 
Most of the features of the Pivot Table are intuitive for the user comfortable with the 
Windows/Office interface.1 The Pivot Table invites experimentation. After a few 
sessions with Pivot Table basics you’ll feel comfortable exploring the more advanced 
features on your own. 
 
 
 
II. Basic Excel 2007 Pivot Table Creation 
 
Source Data Requirements 
The most basic of Pivot Tables is created from source data that’s in a table or range in an 
Excel workbook. Data suitable for use in a Pivot Table must have these characteristics: 
 

1. The top row of data contains column headers. 
2. Each row of data is a record about a particular entity or transaction. 
3. Each column of data holds the same kind of information. 
4. There are no entirely blank rows in the data. 
5. There are no entirely blank columns in the data. 
6. If a column contains numbers, use a zero instead of a blank cell when you 

don’t have a value. 
 
In Excel 2007 a range of data that has the characteristics above can be specifically 
designated as a table. A Pivot Table can still be constructed, however, even if the data 
has not been so designated. In this case, it’s simply called a range. If you generate a Pivot 
Table from a range, the range must have the characteristics named above. Below is an 
example of a range that meets all the characteristics but the first. This data range has no 
header row, making it unsuitable as the source data for a Pivot Table.  
 

                                                      
1 If you’re switching from the 2003 Pivot Table, however, you’ll probably find you spend a bit of 
time at first locating the old features in their new, 2007 locations. 
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Below left is a Pivot Table created from the range with no header row. Below right is the 
version when a header row is added. 
 

 
 
 
 
 
 

Created from invalid source data (no header row).               Created from valid source data. 
 
 
Pivot Table Creation Steps 
1. Make sure your table or range has the characteristics required for Pivot Table source 

data. 
2. Click any single cell in the table or range and 

choose the “Insert” tab on the Excel ribbon. 
3. Find the “Tables” group at left and click the 

PivotTable button to open the “Create 
PivotTable” dialog. 

 
 
 
 

 
 

 
 
 
 
 
4. Because a single cell in your 

source data is current, Excel 
completes the “Table/Range” 
identification for you by “looking” 
left, right, up, and down until it 
encounters a worksheet edge or a 
blank row or column. Excel 
identifies everything inside that 
area as the source data range. 

 
By default, the Pivot Table will be 
created on a new worksheet that 
Excel inserts into the workbook. 
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5. Leave the defaults in the “Create PivotTable” dialog and click OK.  Excel adds a new 
worksheet to the workbook and displays the “PivotTable Field List” and a Pivot 
Table “build space”. 

 
If you’re accustomed to creating Pivot Tables with the 2003 or earlier version of Excel, 
notice that Microsoft has redesigned the field list and revamped the “build space” 
entirely. In addition, the way you build a Pivot Table in 2007 is completely different. 
Unless you change 2007’s default setting back to “Classic PivotTable layout”, you 
can no longer drag items from the Field List and drop them onto the Pivot Table. In 
Excel 2007, you build a Pivot Table by clicking and/or dragging fields from the top 
of the Field List to value areas at the bottom of the Field List. Excel uses this information 
to build the Pivot Table in the build space. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
6. You need at least two fields in a Pivot Table 

report (a row or column field and a data field), 
but three or more fields (a row field, a column 
field, and a data field) are the usual. Drag a field 
name from the top of the list at the top of the 
dialog to one of the “drop areas” at the bottom of 
the dialog. Each field has a check box to its left to 
allow you to easily add (or remove) that column 
data from the Pivot Table. If you turn on the check 

Field names 
from the 
source data. 

Drop zones 
that create 
the Pivot 
Table 
structure. 

“Build 
space”. 
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mark for a text field, the Pivot Table automatically adds that field to the “Row 
Labels” drop area. If you turn on a check mark for a numeric field, the Pivot Table 
automatically adds that field to the “Values” drop area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the illustration above, when the boxes to the left of the text fields “Region” and 
“Product” are checked, these fields are automatically designated as “Row Labels” at 
the bottom of the Field List and appear that way in the Pivot Table build space. 
When the numeric field “Units Sold” is checked, it is automatically designated as a 
“Values” field at the bottom of the Field List and appears in the data area of the 
Pivot Table build space. Because the Pivot Table automatically summarizes anything 
dropped into the data area, the “Units Sold” label is changed to “Sum of Units Sold” 
and Excel applies a sum summary if possible. 
 
 
An Important 2003  2007 Difference 
 
In an Excel 2003 Pivot Table you could drag fields from the Field List and drop them 
directly on the Pivot Table structure in the worksheet. In Excel 2007, you build the 
Pivot Table structure entirely within the Field List. Drag field names from the top of 
the Field List to the Field List drop zones for “Report Filter”, “Column Labels”, 
“Row Labels”, and “Values”. Or, turn on the check box to the left of a Field List field 
name and Excel will locate the field in the drop area that makes most sense. Fields 
that hold text automatically display in the “Row Labels” drop zone. Fields that hold 
numbers automatically display in the “Values” drop zone. Excel builds the Pivot 
Table based on the arrangement of fields in the Field List. You can drag and drop 
field names within the Field List, but not from the Field List to the Pivot Table structure. 2 
 
 

                                                      
2 If you like the old drag-and-drop directly to the Pivot Table, open the 2007 PivotTable Options 
dialog and on the “Display” tab check “Classic PivotTable layout”. 
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7. Drag the “Product” field to from the “Row Labels” area to the “Column Labels” area 
to change the way the data is displayed and summarized. 

When you click off the Pivot Table the field list is hidden. When you click back on 
the Pivot Table the field list redisplays. The field list dialog has an X icon in the 
upper-right-hand corner; you can turn off the display of the field list even if you’re 
working with the Pivot Table. 

 
 
How the Cache is Used in Pivot Table Construction 
At this point in your work with the Pivot Table, its behind-the-scenes operation isn’t 
critical. But it’s a good idea to understand right from the start that Excel creates the Pivot 
Table from a copy of the source table or range that it keeps in cache memory, not 
directly from the source itself. In this way, a Pivot Table is unlike a chart or a formula 
that uses worksheet data. With a chart or formula, when the underlying (source) data 
changes, the chart or formula result also changes automatically. Not so with the Pivot 
Table and its source data. Here are a couple of obvious reasons for this behavior: 

• If your data were being updated often, it would be disconcerting to build 
and manipulate a Pivot Table while its values were constantly changing. 
The kind of data for which a Pivot Table is particularly useful is often 
data that’s updated or added to frequently. 

• You decide when to update the Pivot Table from the data (that is, when to 
“renew” the cache and by extension the Pivot Table) and so capture all 
the updates at one time. This makes Pivot Table operations faster. 

 
 
Refreshing the Pivot Table from Source Data 
When you’re ready to refresh the Pivot Table from the cache and source data (as 
described above): 
1. Click any cell in the Pivot Table to make the Pivot Table active. 
2. A special PivotTable Tools tab displays and contains an “Options” tab. 
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3. Find the “Data” group and click the “Refresh” button.3 Excel updates the Pivot Table 
you created with any changes, additions, or deletions made to the underlying 
worksheet data. 

 
 
 
 
 
 
 
 
 
 
 
 
Building a New Pivot Table Based on an Existing One 
In previous versions of Excel, if you began creating a new Pivot Table using the same 
data with which you’d already created a Pivot Table, a prompt appeared asking if you 
wanted to base the new Pivot Table on the existing one. With Excel 2007, that option is 
no longer available. You can reproduce an existing Pivot Table by selecting it and 
copying it to a new location, but the “original” and the “copy” remain separate Pivot 
Tables. Changes you make to one do not affect the other. 
 
 
 
III. Basic Excel 2007 Pivot Table Modifications 
 
Expand Information 
Use the PivotTable Field List to add additional fields to a Pivot Table. In the example 
below, all eight fields in the source data are used. Notice the filter icons in the field list to 
the right of the “Product” and “Customer” field names. The filter icons are a reminder 
that these fields are showing only some and not all of the data. 

All the fields in the source data cache are used in this Pivot Table. All the field list fields are 
checked on.  
 

                                                      
3 In earlier versions of Excel the Refresh icon was a red exclamation mark. 
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Customer 
names 

Restrict Information 
Restrict the information 
shown in the Pivot Table 
either by removing fields 
(uncheck any field list 
field) or by filtering a field 
to show particular 
instances.  
 
 
At right the “Column Labels” drop down is 
clicked to display the sort and filter dialog 
for this field. A simple way to limit the 
amount of data displayed is to uncheck the 
“Customer” names you don’t want to see in 
the Pivot Table. Here, only one “Customer” 
is checked. 
 
(If you don’t see a drop-down to the right of 
a Pivot Table label, click that field in the 
field list to turn on a drop-down, and use 
that drop-down icon.) 
 
 
 
 
 
 
 
 
 
 

 

Change the Pivot Table View 
With a Pivot Table selected and the context-
specific “PivotTable Tools” tab visible, select the 
“Design” tab and find the “Layout” group. The 
Layout group is divided into options for subtotals 
and grand totals (at left) and report layouts (at 
right). Click the “Report Layout” button to see the 
three possible 2007 Pivot Table layouts: Compact, 
Outline, and Tabular. The illustrations below 
show the differences between these layouts. 
 

“Revenue”, “COGS”, 
and “Profit” fields no 
longer display in the 
Pivot Table. 
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Compact layout (new default for Excel 2007) 
 
In this new view, inner row items are shown in the 
same column as outer row items. This permits 
“rolling up” detail by clicking the minus icon to hide 
inner row information. 
 
 
 
 
 
 
 
 

 
Outline layout  

If you used the Pivot Table in a previous 
version of Excel, this is the layout with 
which you’re familiar. If a row field 
contains two variables (here, “Region” and 
“Date of Sale”), each variable has its own 
column. Region occupies Column A and 
Date of Sale occupies Column B. This 
remains true even if the “Date of Sale” data 

is hidden. In this case, Column B retains the 
header “Date of Sale” and appears empty. 
 

 
Tabular layout 

 
Tabular layout adds an automatic subtotal 
after each outer row field.  
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The New Report Filter 
The pre-2007 Pivot Table had an optional Page Field that allowed the Pivot Table user to 
see all the data in the page field or to limit the view of data by slicing through the data 
by a single Page Field selection. 
 
 
 
 
 
 
 
 
 
 
 
 
The Excel 2007 Pivot Table has replaced the 2003 Page Field with a “Report Filter” field. 
The Report Filter also is optional and is located in the same position in the Pivot Table 
(in the upper left-hand corner). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Set Pivot Table Options 
The Excel 2003 Pivot Table had 
options bundled together in a single 
“PivotTable Options” dialog box. 
The Excel 2007 Pivot Table organizes 
options in a ribbon and in a multi-
tabbed dialog. 
 

The 2007 Report Filter. 
Selection options are (All), a 
single item, or multiple items. 

The 2003 Page Field. 
Selection options are (All) or 

a single item. 
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With a 2007 Pivot Table selected, the “PivotTable Tools” context ribbon item has its own 
“Options” tab. With the “Options” tab selected, these groups are visible: “Active Field”, 
“Group”, “Sort”, “Data”, “Actions”, “Tools”, and “Show/Hide”. 
 
 
 
 
 
 
 
 
To open the multi-tabbed “Options” dialog, choose the drop-down on the “PivotTable” 
button at the far left of the “Options” tab and select Options from the context menu that 
displays. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
Most of the options from the 
single-tab 2003 “PivotTable 
Options” dialog (plus some 
new options) are rearranged 
on this multi-tabbed 2007 
“PivotTable Options” dialog. 
 
 
 
 
 
 
 
 
 

Click the drop-
down on the 

PivotTable button. 

Choose “Options” to open 
the “PivotTable Options 

multi-tabbed dialog. 
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Examples of especially useful option settings: 
 
On the Layout & Format tab choose what to display for empty Pivot Table cells. 
 

 
 
 
 
 

 
On the Totals & Filters tab, turn on and off grand totals for rows and columns. 

 
 
 
 
 

 
On the Display tab, turn on the Classic Pivot Table layout. With the classic layout 
restored you can drag and drop fields from the field list directly onto the Pivot Table in 
the worksheet. (This is the way the 2003 Pivot Table worked.) 

 
 
 

 
On the Printing tab, print or don’t print the expand/collapse buttons that Excel displays 
when you work with a Pivot Table in the default “Compact View”. 

 
 
 
 
 

 
On the Data tab, options to control the source data.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2003’s drill down option 
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Sorting: “External” and “Internal” 
Like the 2003 Pivot Table, the 2007 Pivot Table can be manipulated by some Excel 
features (“external”) but has duplicate “internal” features as well. The sort is an example 
of this kind of feature. 
 
In the (classic view) Pivot Table illustrated below, the “external” Excel sort button on the 
“Data” tab in the “Sort & Filter” group has been used to sort Customer in descending 
order. There’s nothing wrong with this sort, but it has a downside. That is that if you 
modify the Pivot Table (add fields, remove fields, change the layout) Excel isn’t likely to 
remember that you want Customers sorted descending. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
The alternative to an “external” Excel sort is an “internal” Pivot Table sort. Get to this 
sort by clicking the Customer field label drop-down. Along with offering various 
selection options, the context dialog that displays also includes sort options. 

 
 
 
 
 
 
Choosing More Sort Options… 
from this list opens this additional 
“Sort (Customer)” dialog. 
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Formatting, Including Styles and Themes 
You may want to format a single element of a Pivot Table (Teknik Engineers’ data) 
below left) or an entire structural element (the Customer column, below right). The Excel 
2007 Pivot Table allows you to use “regular” Excel formatting tools. 

 
 
 
 
 

In addition to these specific 
formatting tools, the 2007 Office 
applications have style and 
theme-based formatting options. 
Make a cell in the Pivot Table 
current, choose the “Design” tab from the special “PivotTable Tools” tab, and choose the 
“PivotTable Styles” group. Hover the mouse over a style to see how that style looks 
applied to your Pivot Table.  

 
 
Styles types are 
“Custom”, “Light”, 
“Medium”, and 
“Dark”.  
 
If you don’t like any 
of the available color 
schemes in the styles 
group available to 
you, change to one of 
the other 19 Office 
“document themes”. 
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Change to a new document theme by clicking the 
“Page Layout” tab and choosing the “Themes” 
group. Change colors, fonts, and effects 
individually, or select from predefined themes 
that control colors, fonts, and effects. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
Right-click the label for a field and choose 
either Format Cells… (or if the field holds 
numbers either Format Cells… or Number 
Format…) to open the familiar “Format 
Cells” dialog at left. 
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IV. 2007 Pivot Table Filters: New and Repackaged 
 
Anyone familiar with the pre-2007 Pivot Table is familiar with the filter tool represented 
by the drop-down icon to the right of a row field, a column field, or a page field (in 2007 
renamed the report filter and refashioned). 
 
 
 
Select the drop-down icon and choose one or more entries from that field. 
 
The Excel 2007 Pivot Table makes some new filter options available. Some of these 
options are reminiscent of filter options available in the 2003 Autofilter. There are 
several ways to reach these filter options: 

1) Left-click the drop-down icon to the right of a Pivot Table field name to display 
the filter options. 

2) Right-click a row or column label, choose Filter from the context menu that 
displays, and choose a filter type from the context submenu that displays. 

3) Click a field name in the Field List and click the down icon that appears to the 
right of that field name. (A drop-down icon displays only when a field is selected. 

 
This field list illustration shows that Customer, 
Product, and Region are fields in the Pivot Table 
since their check boxes are checked. Filters are 
currently applied to Product and Region. The 
Customer field is selected and a drop-down icon 
displays to its right. None of the other fields show 
this drop-down icon at present. 
 
 

 
 
 
Shown at left are some of the Label 
Filter options, or filters that apply to 
fields that contain text.  
 
The 2007 Pivot Table label filters 
offer multiple ways to limit a 
displayed field.  
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For example, use the “Greater Than…” 
option to displays Product names that are 
alphabetically past the single letter “E”. 
The filtered list includes Evaporator Fin 
Comb, Freezestat, Freon Leak Repair Kit, 
etc. but not A/C Capacitor, A/C 
Condensate Pump, Compressor 
Crankcase Heater, etc. 
 

 
 
 
Shown at left is a display of Value 
Filter options for the “Customer” 
field. In the illustration the “Greater 
Than…” filter has been selected as 
a value filter for the “Units Sold” 
field. The filter is set to show only 
Customers whose sum of units sold 
for a product is greater than 40. 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 

 
 
 

Before the Value Filter is applied. 

After the Value Filter is applied. 
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Clicking the drop-down icon for a date field in the Field List gives access to what are 
called Date Filters. 
 
Selection options for dates 

 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Choosing a Value Filter for a field and then selecting the Top Ten… option displays the 
familiar 2003 “Top 10 Filter” dialog. 

 
 
 
 
 
 
 
 

This example shows a top 10 filter for a field named Product. 

A submenu also 
provides a selection of 
grouping options for 

dates. A special dialog 
described below 

expands these options. 
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V. 2007 Pivot Table Grouping Options 
 
Group (and Select) by Dates 
If your source data has many individual dates, grouping by date can be critical in order 
to make a useful Pivot Table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The 2007 Pivot Table has expanded date selection and grouping options. 
 
Right-click a date field label and choose Group…to open the 2003 “Grouping” dialog. 
This dialog is specific for dates. 
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A Pivot Table that’s overly detailed with date data can be quickly summarized by dates. 
In the illustration below, data that appears in the data source with day by day records 
have been grouped by date month and date year. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Group by Text Fields 
Grouping by text labels in the 
2007 Pivot Table works the 
same way it did in the 2003 
Pivot Table.  
 
In the illustration at right, the 
first five entries under the 
“Customer” label were 
selected. The selection was 
right-clicked, and the Group 
option was selected. The same 
process was applied to the 6th 
through 13th entries.  
 
A “virtual” column (here 
renamed “Type”) is added. 
Each new grouping is assigned 
a generic name unless you 
replace it with your own name. 
To remove virtual groupings, 
select a group, right-click, and 
choose Ungroup. 



 

Page  21 

VI. 2007 Pivot Table Calculations 
 
Default Summary Calculations 
The summary calculation defaults for the 2007 Pivot Table are: 
 

1) If an item designated as a Pivot Table value field is a number, it’s summarized by 
a SUM operation. 

2) If an item designated as a Pivot Table value field is text, it’s summarized by the 
COUNT operation. 

3) If an item designated as a Pivot Table value field contains all numbers except for 
one or more blank cells, Excel treats the field as a text field and summarizes with 
a COUNT. (You can override this default and change the summary from 
COUNT to SUM.) 

 
 
Basic Summary Calculations 
Along with the default summary operations SUM and COUNT, the Pivot Table has a 
variety of other summary operations. To see the list of these additional operations, right-
click the label for a value field and choose the Value Field Settings… option from the 
context menu that displays. Excel opens the “Value Field Settings” dialog for the 
selected value field. 
 
On the “Summarize by” tab in this dialog are the summary options available: Sum, 
Count, Average, Max, Min, Product, Count Numbers, StdDev, StdDevp, Var, and Varp.  
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Intermediate Summary Calculations 
In the same dialog but on the “Show values as” tab, the Pivot Table displays more 
advanced summary options such as “Difference From”, “% Of”, “% Difference From”, 
etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Depending on the option you select you may or may not have to provide more 
information to the Pivot Table so it can perform the operation you selected. For example, 
if you choose to show values as “Difference From”, you’re prompted to designate a 
“Base field” and a “Base item”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

End of Beginning Guide to the Excel 2007 Pivot Table 
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